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Welcome

• This session has captions and is recorded

• Please use the  Q&A to ask questions and chat for general 

correspondance

• Slides, a recording, and a transcript will be made available via email 

in the coming days

• I welcome any feedback, follow-up questions, or suggested topics 

for future training
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About AbilityNet
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Agenda

• Applying accessibility principles to documents

• Creating accessible templates in Word

• Creating accessible content with Word

• PDF accessibility

• Accessible forms options
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Example documents

• Inaccessible Word document

• More accessible Word document

• PDF version

https://abilitynet.org.uk/sites/abilitynet.org.uk/files/How%20to%20create%20accessible%20documents%20with%20Word%20and%20PDF%20-%20Microsoft%20Word%20with%20accessibility%20issues.docx
https://abilitynet.org.uk/sites/abilitynet.org.uk/files/How%20to%20create%20accessible%20documents%20with%20Word%20and%20PDF%20-%20Making%20Microsoft%20Word%20Documents%20Accessible.docx
https://abilitynet.org.uk/sites/abilitynet.org.uk/files/How%20to%20create%20accessible%20documents%20with%20Word%20and%20PDF%20-%20Making%20Microsoft%20Word%20Documents%20Accessible.pdf
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Poll 1

How much experience do you have with document 

accessibility?

• None or little experience

• Moderately experienced

• Very experienced
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Applying accessibility principles to 

documents
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Accessibility principles: POUR

Perceivable: Content is presented in ways that can be perceived by all

Operable: User interface components and navigation must be operable

Understandable: Information and the operation of user interface must be understandable

Robust: Content is reliable and compatible with assistive technology and standards
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Remember, some documents:

• Convey information visually – so they need to be perceivable if 

accessed through assistive technology

• Are interactive – so they need to be operable

• Request user inputs – so they need to minimise user errors

• Will have different levels of support for assistive technology

Choosing the correct document format will 

influence the effort involved to make it accessible
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International accessibility standards

Web Content Accessibility Guidelines 

(WCAG) 2.1 Level AA 

ETSI EN 301 549

• Aligned to WCAG 2.1 AA

• Section 10 covers non-web documents

Note – not all WCAG requirements 

transfer to documents

https://www.etsi.org/deliver/etsi_en/301500_301599/301549/03.01.01_60/en_301549v030101p.pdf


How to create accessible documents with Word and PDF | Katey Hügi | May 2023

Characteristics of accessible documents

• Searchable text

• Navigational aids (bookmarks, headings, table of contents)

• Metadata e.g. title and document language

• Programmatic document structure e.g. tags 

• Logical reading order 

• Interactive form fields that can be tabbed to with keyboard

• Alternative text for non-text elements

• Appropriately formatted tables
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What types of document format are available?

Office & editable 

formats

PDF - print 

focused formats
ePub & HTML 

based formats
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Accessibility pros and cons for document formats

Format Pros Cons

Word Office format 
- *docx

• Easiest to make accessible
• Compatible with wide range of assistive tech 

& devices
• Can be personalised by the user

• Interactive features & complex tables are not 
accessible

• Accessibility compromised by security settings

PDF • All users get the same view & difficult to edit
• Interactive activities & complex tables can be 

made accessible

• Creating / fixing accessible PDFs requires 
specialist skills and tools

• Cannot be personalised by the user

HTML based format
e.g. web page, ePub

• All users get the same view but can be 
personalised.

• Compatible with wide range of assistive tech 
& devices

• Interactive activities & complex tables can be 
made accessible

• Accessibility may need specialist skills or tools 
that are not accessible out of the box.

• No default viewer at the moment for ePub
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Poll 2

What document formats does your 

organisation post online or share?

• Editable documents (e.g. Word)

• Presentations (e.g. PowerPoint)

• Spreadsheets (e.g. Excel)

• Locked documents (e.g. PDFs)

• Other – please state in chat pane
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Questions?
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Creating accessible templates 

to avoid potential issues
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Word template: Styles and structure

Set up styles for:

• Headings 1 – 6: use outline level to set heading level

• Normal text: think about paragraph and line spacing, font style and colour

• Bulleted and numbered lists: ensure there are styles for common types of 

text
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Example: Setting heading level in Word

• On the Home tab, in 

the Styles group, select 

a heading style, for 

example, Heading 

1 or Heading 2. 

• Do not use headings 

only for styling.
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Font size, style and colour

• Text size of 12 point or higher will benefit most 

users, but Word documents allow easy text-

resizing

• Avoid overly-decorative fonts and continuous 

capitalisation as they can be difficult to read

• Provide at least a 4.5:1 colour contrast between 

text and background (3:1 for large text) – TPGi 

colour contrast analyser

https://www.tpgi.com/color-contrast-checker/
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Decorative content

Headers and footers

• Use built in tools to add headers, page numbers etc. so they are 

ignored by assistive technology

Background images

• Ensure background graphics are marked as decorative
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Accessible template requirements

• Style and structure

• Accessible text defaults

• Logical reading order

• Sufficient colour contrast

• Decorative content is marked as such
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Questions?
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Adding content 

to documents
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Poll 3

Does your organisation check 

accessibility when documents are created?

• Yes

• No

• Sometimes

• Don’t know

• We have a policy but it’s not policed
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Types of content we need to make accessible

Text

Images

Tables

Links

Lists and headings

Form fields

Media

Charts
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What do we mean by accessible text?

• It is not an image.

• You can select and copy it.

• When you select all text / convert to a text document, it 

has the correct reading order.
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Example: What can we do wrong with lists?
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Formatting – Bullets and lists

• Use bullets and ordered 

lists as opposed to 

images, clip-art, etc to 

create lists.

• List paragraph styles 

can be used to adapt 

spacing and fonts
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Adding ALT text to graphics in Word

From the images

• Right click an image

• Edit Alt Text

• Type a description or mark as 

decorative

From accessibility checker

• Select dropdown on graphic and 

choose appropriate option
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Example: Images and alternative descriptions

An empty beach

A

Colour line graph for cinema 
attendance in UK between 1990 
and 2010 by age group.

B

Animation of satellite images of storm Doris crossing UK and Ireland.

C
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Charts and SmartArt

• For charts and SmartArt, alt text can be 

added for the entire image

• Save imported charts as images and 

add alt text before conversion to PDF

• Provide longer descriptions if necessary 

for complex charts and diagrams
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Use of colour

Ensure that colour is not the only way 

that information is communicated.

• links should have some decoration (e.g. 

underlined) and charts shouldn’t rely on 

colour vision.
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Links

Ensure that the purpose of links 

is obvious and self-evident from 

tabbing onto them. 

• Where possible, enter a 

meaningful name into the text 

to display field.

• Use the screentip pop-up to 

provide a tooltip for users.



How to create accessible documents with Word and PDF | Katey Hügi | May 2023

Formatting – Tables

Use table headers:

• Table Design > Table Style Options

• Select Header Row and First Column (if first 

column is acting as a header)

• In Word Select Table properties: “Repeat as 

header row at the top of each page”

• Deselect “Allow row to break across pages”

Do not use tables for formatting!
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Formatting - Columns

• Use columns rather than just 

using SPACE or TAB to align text

• Laying out text using the built-in 

column functionality is an 

accessible layout method and the 

correct column reading order will 

be inherited by tagged PDFs 

created from the Word document
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Formatting - Text boxes

• Avoid adding text boxes via the inbuilt Word 

functionality – these are not easily accessible to 

screen reader users and are not placed in the 

correct reading order for assistive technology

• Instead create text boxes by adding a border and 

positioned text to paragraphs
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Table of contents

• A table of contents can be added for 

longer documents via References 

>Table of Contents using the 

heading structure you have defined

• Including a table of contents helps 

users to navigate themselves with an 

outline of the content
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File name and title

• Provide a descriptive file name for 

your file.

• Providing a descriptive title will 

ensure this is inherited by a PDF 

created from your Word file
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Microsoft Word accessibility

Golden Rules: 

• use the formatting tools to provide meaningful structure with built-in 

headings and styles

• ensure that meaningful non-text content (e.g. images) has 

alternative text

• use colour and meaningful hyperlink text to ensure perceivability

Microsoft: Make your Word documents accessible

https://support.office.com/en-us/article/Make-your-Word-documents-accessible-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
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Microsoft Office Accessibility Checker

The Accessibility Checker finds 

accessibility issues, explains why 

you should fix these issues and 

how to fix them: Review > Check 

Accessibility

Google docs – see Grackle suite

https://www.grackledocs.com/
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Questions?
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Optional break

42
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PDF Accessibility
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PDF accessibility – why is this so challenging?

Why are PDFs so challenging to make accessible?
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The challenge of making PDFs accessible

• Often scanned documents

• Require additional accessibility tags to add structure

• Don’t have great usability on mobile

• Often heavily designed and complex layouts

• Some types of content (such as mathematical and 
scientific notation) have limited accessibly support

• Additional software and skills required to make PDFs 
accessible
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Additional requirements for accessible PDFs

• Text is not an image

• Permissions are set correctly

• File has appropriate metadata e.g. title and language

• Content is tagged

• Applies alternative text, semantics and reading order
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PDF accessibility checkers

• Adobe Acrobat Pro – check and fix

• PAC 2021 – checker, freeware for Windows

• CommonLook PDF Validator (require Acrobat Standard or Pro)

• PAVE – online tools, some fixing possible

Manual checks will still be required

https://www.access-for-all.ch/en/pdf-accessibility-checker.html
https://commonlook.com/accessibility-software/pdf-validator/
https://pave-pdf.org/?lang=en
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Exporting Word to accessible PDF

• Add Title and other metadata

• Convert embedded Office objects to images 

and add alt text

• Select the following options in Save As > 

PDF > Options:

• Create bookmarks using headings

• Document structure tags for accessibility
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Lightweight PDF check

1. Run the PDF file through a checker. Look for:

• Image only file – this will need OCRing

• No tags – this will need lots of remediation if complex structure

• Permissions affecting accessibility

2. Tab through the file to check if links and fields are interactive

3. Use View > Zoom > Reflow and Save > Other > Text (accessibility) and 

check

• Check for reflow issues and reading order issues
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Reading order 

issues in PDF

• Any content that is not 

laid out linearly could 

be read in the wrong 

order.

• Without tags, content 

likely to read in the 

order it was added to 

files and text will be 

concatenated where 

there were line breaks.
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Using Acrobat Pro to check & fix issues

1. Run Full Check and 

view report

2. Fix metadata and 

permissions issues

3. Add tags or correct 

tagging where 

necessary
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Accessible Forms
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Accessible Forms – Word vs PDF

Word Forms

• More accessible if plain text e.g. leave 

empty space to fill out the form. 

• Built-in form controls have limited 

accessibility

• Protecting content so only form 

fields can be edited makes the file 

inaccessible

PDF forms

• Can be made accessible if form 

fields are tagged along with the 

rest of the file

• Complex forms will be costly to 

make accessible

• Many users will struggle to 

complete the form digitally
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Accessible PDF forms requirements

In Adobe Acrobat every field needs to

be added, given a tooltip & tagged

Tab order must also be checked

Forms can also be created

in Adobe InDesign
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Easy accessible online form solutions

• Microsoft Forms

• Google Forms

• Online survey tools e.g. 

Survey Monkey

Remember data 

protection
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Summary

• Accessibility requirements apply to all digital documents

• Always consider if information needs to be in another format, or 

could be presented as HTML. 

• Accessibility is best implemented at the source when creating PDF 

documents and a good initial publication process is essential

• Ensure you have a clear accessibility documents policy, good 

templates and procedures for checking content.
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Questions?
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Resources

• Microsoft: Create accessible Office documents

• Adobe: PDF accessibility overview

• Daisy Consortium: WordToEPUB - Conversion tool for ePUB from Word

• Web Accessibility Initiative: alt decision tree

• Benetech: Poet alternative text training tool

• WebAIM: Accessibility techniques for older versions of Word

https://support.microsoft.com/en-us/office/create-accessible-office-documents-868ecfcd-4f00-4224-b881-a65537a7c155
https://www.adobe.com/accessibility/pdf/pdf-accessibility-overview.html
https://daisy.org/activities/software/wordtoepub/
https://daisy.org/activities/software/wordtoepub/
https://daisy.org/activities/software/wordtoepub/
https://daisy.org/activities/software/wordtoepub/
https://daisy.org/activities/software/wordtoepub/
https://www.w3.org/WAI/tutorials/images/decision-tree/
https://poet.diagramcenter.org/
https://webaim.org/techniques/word/
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Thank you

Katey Hügi

May 2023


